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 Protocol P-13-39 

Identification and Enumeration of Diatoms on Microscope Slides  
  

1. PURPOSE 

1.1. This protocol describes Phycology Section procedures for analyzing diatom samples.  
It applies to the major kinds of samples analyzed, including those collected by local, 
state and federal agencies and the National Ecological Observatory Network 
(NEON) program. The previous version of this protocol (Revision 1, 03/02) 
describes procedures used in the Phycology Section from 2001 through about 2017, 
in particular for analysis of samples for the U.S.G.S. National Water-Quality 
Assessment program (NAWQA). 

1.2. This protocol describes procedures for analyzing diatoms on microscope slides made 
from three types of algae samples; quantitative periphyton, qualitative periphyton, 
and phytoplankton. [These correspond, respectively, to the Richest Targeted Habitat 
(RTH) and  Depositional Targeted Habitat (DTH), Qualitative Multihabitat (QMH), 
and phytoplankton samples (Porter et al., 1993; Moulton et al., 2002), collected as 
part of the U.S. Geological Survey’s (USGS) National Water-Quality Assessment 
Program (NAWQA).] 

  

1.2.1. The purpose of periphyton sample analysis is to estimate the proportion of 
diatom taxa found in a count of 600 valves (one-half of an individual diatom 
cell).  Results can later be combined with those from analysis of the soft-algae 
component of the same sample (Protocol P-13-63) to provide data on algal 
densities (as cells per cm2 of sampling surface) and amount of algal biovolume 
(μm3 per cm2 of sampling surface) at a sampling site. 

1.2.2. The purpose of the qualitative sample analysis is to identify as many taxa 
present in the sample as possible, to provide an accurate and uniform estimate of 
algal taxa richness in a stream reach.  An underlying assumption is that although 
all algal taxa present in a sample (or on a slide prepared from a sample) will not 
be identified, most species will be found during a reasonable search.  If that 
effort is consistent among taxonomists, results from analyses of samples and 
slides will be comparable among analysts and contract laboratories (Porter 
1994).  Unlike the count of a periphyton sample, the number of diatoms to be 
counted is not fixed.  Instead, the analyst scans the slide until the rate at which 
new species are encountered, per 100 specimens observed, drops below a 
defined number, or a time limit is reached. 

1.2.3. The purpose of phytoplankton sample analysis is similar to that of periphyton 
samples, except that the quantitative results are expressed in number of cells per 
volume of water.  Phytoplankton samples are collected from the water column, 
using various sampling techniques and collection devices. 
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1. SCOPE 

2.1. This protocol covers the identification and enumeration of diatom taxa mounted on 
microscope slides and procedures for recording data using the “Tabulator” program 
(Cotter 2002).  As of 2017, all Phycology Section diatom analysts use the 
“Tabulator” program. Most of the instructions for using “Tabulator” are in the 
User’s Guide (Cotter 2002).  Some of those instructions are summarized here to 
provide an overview of the program and to help clarify how it is used in the process 
of analyzing samples.  Some procedures not included in the “Tabulator” manual are 
described here. 

2.2. This procedure is applicable to the analysis of diatoms in algae samples collected by 
the RTH, DTH, QMH, and phytoplankton sampling protocols of the USGS 
NAWQA program. It is applicable to periphyton and phytoplankton samples 
collected as part of the Neon program. 

2.3. Personnel responsible for these procedures include diatom analysts and data entry 
personnel. 

2.4. In March 2002, the previous version of this Protocol (RTH and DTH samples only) 
was merged with Protocol P-13-61, which described procedures for analysis of 
NAWQA QMH samples.  

 

2. REFERENCES 
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Water-Quality Assessment program, U.S. Geological Survey Open-File Report 
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Sciences. 
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[add references for NEON periphyton and phytoplankton field sampling protocols; EPA 
NARS field sampling methods; Version 2 of NAWQA field protocols] 

 

3. APPARATUS/EQUIPMENT 

4.1. Compound microscope: 

4.1.1. Oil immersion objective (100x) with a numerical aperture of at least 1.3; 

4.1.2. Eyepieces of 10-15x; 

4.1.3. DIC (differential interference contrast) or bright field condenser; 

4.1.4.  

4.1.5. High intensity light source. 

4.1.6 Digital camera – (e.g., Leica DFC 3000G with Software LAS V4.6)  

4.2. Desktop computer (located at microscope).  

4.2.1. Software:  “Tabulator” program by Patrick Cotter (MS Visual Basic); 

4.2.2. Network connection to ANSP Phycology Section databases (ANSP staff only). 

 

4. METHODS 

5.1. Diatom counts. 

5.1.1. Review the “Diatom Slide Preparation Form” and the “Diatom Slide Analysis 
Form” (Figure 1) contained in the “Diatom Analysis” folder and transmitted 
with the diatom slides from the Diatom Preparation Lab.  The “Diatom Slide 
Analysis Form” lists sample information for each slide it accompanies, and 
provides space next to each listed slide to initial and date when a count is 
finished.  It also serves as a chain-of-custody record; it must be signed by the 
person delivering the slides and the person receiving them.  Make sure that the 
slides correspond with the entries on the form. Note and resolve any 
discrepancies. 

5.1.2. Scan slides at low to medium magnification (100x to 450x) to confirm that 
diatoms are evenly distributed on the coverslip, and are at a density appropriate 
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for efficient counting. At high magnification (1000x), there should be between 
5-10 diatoms per field.  If there are problems with dispersion or density that 
would compromise the quality and accuracy of the analysis, discuss these with 
Diatom Preparation Lab personnel and have new slides made.  Avoid counting 
diatoms in any disrupted areas of the mount, particularly edges that have 
optical aberrations.  If diatoms on the slides are very sparse, refer to procedures 
in Protocol No. P-13-49 for handling low-density samples.  Always save any 
count data generated for a sample, even if the number of valves or frustules is 
low (e.g., <100). 

5.1.3. Because slides may need to be recounted for QA/QC purposes, it is important 
to clearly document the areas of a slide scanned during a count. After the 
preliminary slide examination, secure the slide in the mechanical stage and 
record the stage micrometer coordinates of the edge of the first transect (row or 
column) to be counted (the format should be the following: start x=nn.n, 
y=nn.n; end x=nn.n, y=nn.n). Transects are narrow, horizontal or vertical, 
rectangular areas (strips) of the slide with width equal to the field of view. Start 
transects far enough from the coverslip edge to avoid optical distortion and 
areas with uneven distribution of diatoms, and end them near the opposite 
coverslip edge, again avoiding marginal areas. Record the coordinates of the 
last field counted, and the beginning and end of all other transects. Record the 
coordinates in the Tabulator count note. In the count note of the first of a series 
(e.g., subproject) of samples, you may want to record your typical procedure 
for positioning a count transect (e.g., Start point in the center of the upper -as 
seen under the microscope- part of the slide, far enough from the slide edge to 
avoid area with uneven distribution of diatoms. Then vertical transects -
columns- as needed).  

 

5.1.4. When the first field is focused under oil immersion, begin using the 
“Tabulator” program, following the instructions in the manual; some steps are 
summarized below. After opening the program, the first screen encountered is 
the Count Information page. Click the “new” button along the bottom edge of 
the page. Most fields will automatically fill with default information if this is 
not the first slide in the subproject to be counted; otherwise data must be 
added.  Enter data in the fields in the “Slide” box at the top of the form. Click 
the “Verify Slide” button to reconfirm that the slide information is in the 
database. Fill in the other fields in the form, including “Frustules or Valves” 
and “Count Type.”  For RTH and DTH samples, choose “Valves” and then 
“600 valves (300 cells).”  For QMH samples, choose “Frustules” and then 
“NAWQA Qualitative (diatoms).”  (Note that the selection in the “Frustules or 
Valves” box determines the choices available in the “Count Type” box).  Click 
the “Save” button. 

5.1.5. After the preliminary information is recorded, click the “Count Now” button. 
Several small text boxes are displayed to confirm data entry, and then the main 
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“Tabulator” page appears. Before counting can proceed, select a taxa list from 
the bottom right “Choose List” box.  The “Tabulator” manual describes how to 
create new lists and add new taxa to existing lists. 

5.1.6. Before beginning the count, click the “Note” box in the central portion of the 
“Tabulator” window and record the start circle coordinates (numbers on the 
microscope stage). Coordinates of the first (and last) field of each transect 
should be recorded. 

5.1.7. As the count commences, enter taxa observed using the discrete three-digit 
codes established during the taxa list building process or directly selecting taxa 
from the list in the right part of the screen by clicking on the taxon name. Enter 
codes with the numeric keypad on the computer keyboard or click on the taxon 
name the numbers of times needed. Record multiple examples of a single taxon 
either with code: “322+10 enter,” for example; or by repeated hits of the enter 
key “322 enter, enter, etc.” Taxa may also be subtracted by typing the taxon 
code, followed by a minus sign and the number to be subtracted: “322-1 enter,” 
for example. The program will signal an alert when the count total, as 
established by the count type, is reached (quantitative counts only).  

On average, analysis of a slide should take approximately two hours; in no case 
should it exceed four hours. This does not include time spent learning new taxa 
when analyzing the first few samples in a new geographic location. 

5.1.7.1. Quantitative periphyton analysis. Count 600 valves. The number of valves 
counted should be within 600 + 5%. To avoid exceeding the target value 
for > 30 valves (5%), in dense samples count only half or a quarter of the 
last field of view. Samples which are still  very sparse after all possible 
expedients have been applied during diatom slide preparation 
(concentrating etc.) should be treated as an exception. For these samples 
apply the following. VERY-SPARSE SAMPLES COUNTS: Stop 
counting immediately if there are < 20 valves in a 12 mm transect. 
Otherwise count for 4 hours or count 6 transects ( average length = 12 
mm; total length of all transects 72 mm), whichever comes first. The 
minimum target (total number of valves counted for these very-sparse 
samples counts) should be 100 valves. If, after counting for 4 hours the 
total number of valves counted is between 500 and 600, continue counting 
until the 600 valves target is reached. Count all partial valves that are more 
than 50% of the valve or that contain unique features such as recognizable 
central areas or distinct ends.  Count all valves and fragments that extend 
at least halfway into the field of view.  

5.1.7.2. Qualitative multi-habitat (QMH) periphyton analysis.  The stopping rule 
for QMH samples is: “Taxa found on semi-permanent slides are examined 
and identified in intervals (groups) of 100 frustules or valves.  When 
examining the first interval of 100 individuals, determine if any taxon 
constitutes 40 percent or more of the total.  Such predominant taxa should 
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not be tallied in subsequent intervals.  Examine a minimum of 10 intervals 
(1000 individuals).  Continue scanning intervals until two consecutive 
intervals have been completed in which two or fewer new taxa are 
encountered.  It is unnecessary to scan more than 50 intervals (5000 
individuals) per sample.  Record the number of intervals scanned on the 
laboratory data sheet” (Porter 1994).   

Use the following procedure for counting QMH samples with the 
“Tabulator” program.  Count the first interval as if it were a regular RTH 
or DTH sample.  That is, record in “Tabulator” the occurrence of each 
frustule viewed under the microscope.  Once the first 100 hundred 
frustules have been counted, generate an on-screen report for the count by 
going to the File menu on the “Tabulator” screen and selecting Print 
Count.  From this report, determine if any taxa in the first interval equaled 
or exceeded a relative abundance of 40%.  Exclude these taxa from the 
remainder of the analysis. Close the on-screen report.  Starting with the 
second interval, keep track of the number of frustules by using a hand 
counter.  Record occurrence of a new species (species not encountered in 
the first interval) in “Tabulator” only once, the first time it is encountered.  
Each time an interval is finished, type “r” and then hit enter on the 
keyboard to proceed with the next interval.  A message will appear: “Are 
you sure you want to end this interval?”  Hit yes.   “End Row?” (where 
“?” is the number of the row just completed), will then appear in the 

“Count Entries” window.  If the 9th and 10th intervals contain two or 

fewer new taxa, then stop the analysis at the end of the 10th interval.  
Otherwise, continue the analysis until 2 consecutive intervals are found for 
which no more than 2 new species are recorded, up to a maximum of 50 
intervals (5000 frustules). 

5.1.8. When the count is finished, return to the Count Information page to complete 
the boxes “Date Count Finished,” “Scan Length,” and “Hours To Complete.”  
Then return to the “Tabulator” window and print a “Count Report” and check it 
carefully for errors.  Make adjustments, if necessary, print a final copy, sign it, 
and put it in the “Diatom Analysis” folder.  In “Tabulator,” select “Save 
Count” from the “File” menu in the top left of the “Tabulator” window. This 
saves the count to the underlying database.  If the count data are not saved 
before exiting “Tabulator,” the information will be retained by the program but 
not added to a database.  To save the data if this occurs, reopen the “Tabulator” 
program, enter the required information about the sample, click “Count Now” 
to get to the “Tabulator” window, and select “Save Count” from the “File 
Menu.”  

Put initials and date on the “Diatom Slide Analysis” form next to the entry for 
the slide just counted.  Return it and any other related forms to the “Diatom 
Analysis” folder.  Clean slides of immersion oil with alcohol.  When finished 
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analyzing all slides in a subproject, give the slides and “Diatom Analysis” 
folder to the Phycology Section Diatom Prep Lab Manager. 

5.2.  Biovolume measurements. 

5.2.1. NAWQA sample analysis requires biovolume measurements for each taxon 
occurring in abundance of 5% or more in any one sample in a study unit.  
Criteria for determining how many measurements to make of each taxon for 
each NAWQA study unit changed slightly from the beginning of algal analyses 
(1995).  The basic rule, as originally specified by NAWQA, was to make 15 
sets of measurements.  As the number of measurements for taxa accumulated, 
however, the criterion was changed.  Since 1999, only 5 additional sets of 
measurements are required for taxa in new study units if the range of those 5 
sets falls within the range of all previous measurements from other study units.  
If the ranges do not overlap, make a full 15 measurements for the taxon. 
Biovolume measurements can be made during the routine process of counting 
slides or after all slides for a Subproject have been counted.  It is likely that 
criteria for selecting specimens to measure will evolve as the number of 
measurements for common taxa accumulates. 

5.2.2. Use the form “frmBiovolumeVerification” in the PHYCLGY database to 
determine which taxa occur in abundance of 5% or more in samples in a 
subproject, and therefore must be measured.  The form also shows the number 
of measurements that are already entered in the database, and minimum, 
maximum and average biovolumes.  Print the results. To find which slides 
contain the most specimens of the taxa to be measured, use the query 
“qryfind’>5% taxa.”  Print the results.  Both of the above printouts should be 
included in the Diatom Analysis folder. 

5.2.3. Use the Biovolume Calculation feature of “Tabulator” as a convenient means 
for calculating and entering biovolume data directly into the NADED database 
(ANSP staff) or the “Tabulator” back-end database (subcontractors).  The 
BioVol program can also be used.  It is essentially a stand-alone version of the 
“Biovolume Calculation” feature in “Tabulator.”  It is located in 
G:\Phycdata\VBAppInstalls\BioVol. 

Choose the first microscope slide with taxa to be measured, open the 
“Tabulator” program, and enter the “Slide ID.”  Select the “Find Counts” and 
“Count Now” buttons, and make the choices necessary to get to the 
“Tabulator” screen.  Select “Biovolume Calculation” from the Documentation 
menu at the top of the “Tabulator” screen.  The fields labeled Sample ID, 
Subsample ID, Slide Replicate ID, Microscope, Lens, and Conversion Factor 
are automatically filled with information for the slide you entered.  Drop-down 
boxes can be used to modify any of this information if needed.  The 
Microscope ID, Lens ID and Conversion Factor fields are linked.  As soon as a 
given Microscope and Lens are selected from the drop-down box, a conversion 
factor for that microscope is shown in the Conversion Factor field.  Since 
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conversion factors are already stored in a database table accessible to the 
“Tabulator” program, and they are used in the calculation of biovolumes, it is 
extremely important NOT to make any conversion in the measurements before 
entering them in the required field of the Biovolume Calculations form.   

Enter the NADED Taxon ID for the specimen being measured.  The taxon 
name field will fill-in automatically.  Then select the correct shape for the 
taxon.  If it is already filled-in, make sure it is correct.  Consult the Biovolume 
Measurements table in NADED as a reference source for assigning shapes.  
The table contains shape codes that have been assigned to taxa in the past. The 
shape specifies a specific formula to be used to calculate biovolume.  The 
measurement fields that must be filled-in for that shape will appear on the 
form.  Be sure to enter data for all required dimensions. 

The number of measurements made for a taxon are shown in the field labeled 
“# of Measurements this session.”  If measurements must be corrected, click 
the “Datasheet” button at the bottom of the form and make changes in the 
appropriate record. After all measurements for a taxon have been entered, press 
the “New taxon” button at the bottom left of the form to begin the process with 
a different taxon.  When ready to go to a new slide to make measurements, 
enter new data in the “Slide” box and follow same steps described above. 

The Biovolume Summary window is a useful feature for keeping track of 
measurements and to check that all have been made for a study unit.  It is also 
useful for comparing measurements for a taxon with all others made for that 
taxon.  It is accessed through the “Edit” menu on the top left of the Biovolume 
Calculation window.  Select a subproject in the central menu, click the 
“Diatom” button to the right, and all taxa requiring biovolume measurements 
are displayed. Single taxa can be selected and double clicked to display 
biovolume measurements for that taxon over all subprojects.  This is helpful 
for determining whether averages of current measurements fit in the ranges 
determined for that taxon in other study units. Again, reviewing data at this 
level can prevent significant errors. 

5.3.  Specimen documentation. 

5.3.1. Requirements for documenting diatom species vary with project. In general, 
take good quality digital micrographs of new, unknown, unusual and 
outstanding diatom specimens. This allows comparison with reference 
specimens and facilitates examination by specialists.  For special purposes, 
specimens may be circled with a diamond scribe. Use the following two 
features, accessible from the Tabulate screen, to assist with documentation.  

5.3.2. Circle specimens.  Click the “Circle” button in the “Tabulation” box in the 
“Tabulator” window to activate the New Circle on Slide window.  Values that 
appear in the fields for Taxon name, Microscope, Date, and Circler default 
from the “Tabulator” screen.  Enter the Circle Number, Horizontal and Vertical 
Coordinates (from microscope stage), and both Cover Slip Sector (1-16) and 
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specimen location. Record extra information concerning documentation in the 
“Note” box, if necessary.  You can click the “Datasheet” button to review 
records for existing circles.   

 

 

 

 

 

 

 

5.3.3. Image specimens.  Click the “Image” button in the “Tabulation” box in the 
“Tabulator” window to activate the “Images” window. All data in fields in this 
window automatically default to those in the “Tabulator” window, including 
the name of the last taxon counted.  If the taxon is not the one you want to 
document, choose a different name from the drop down box of the same field.  

Fill in values in fields under the four tabs. 

“Subject”  B Taxon name and dimension measurements.   

Add information in the “Length,” “Width/Diameter,” and “Striae 
Density” fields, making sure that the measurements are expressed in 
microns. If your ocular scale is not 1:1 you must make the necessary 
conversions.  The boxes “Quality” and “Public?” can be left untouched 
since this is information that will be added by Academy personnel 
reviewing the image before it is made available on the Phycology 
Section's web site. We are currently not using the “Caption” field and 
it can be left blank.  Add notes referring to any characteristic of the 
taxon being imaged, or any taxonomic problems that you may have 
had with it during sample analysis, to the “Notes” field. 

“Who, where, when” B Person taking image, location, image device, 
etc. 

Enter the location from which you are working and the “Image 
Device” you are using for capturing the image. In the “People” box fill 
the fields labeled “Determiner,” “Imager” and “Adder” with the proper 
information. Most of these fields, except for “Image Device” will be 
automatically filled in with the same data that were entered in the 
fields in the ”Count Information” screen. 

“ANSP Sample”  B Sample identification information 

Fields are filled in automatically. 

     1   2  3 

    
 4   5  6 

     7   8  9 
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Digital images must be taken following the steps and 
recommendations given in the Taxonomic Guidelines document.  

When all information in the "Images" screen is complete, including in 
the tabbed boxes, press the "Save Record" button located on the top 
right portion. This will save all data in the NADED database. It will 
also assign the next available identification number, which will appear 
in the Image ID field, in the upper left hand corner.  Record this 
number for future reference. At the time the image data are saved, the 
identification number (e.g., IM000027) that is assigned is 
automatically recorded in the “DigitalImage” table of the 
ALGAEIMAGE database in a field called “ImageID.”  A second field 
called “ImageFileName” is filled-in at the same time.  It contains the 
identification number with the extension “.png” added (e.g., 
IM000027.png), which corresponds to the file format used by ANSP to 
store image files. 

Open the imaging program you are using (e.g.,  Photoshop v 5.5) and 
edit the image as desired.  Save the image in the “Originals” folder 
located in G:\Phycdata\DATABASE\Images\images. Name the file the 
“Image FileName” recorded previously. 

 

 

6. QUALITY ASSURANCE/QUALITY CONTROL  

6.1. Sample and slide quality can affect the outcome of using these procedures.  Minor 
deviations that do not affect the area scanned or number of specimens observed 
should be described in the Note portion (click the “Note” button) of the 
“Tabulator” program.  Other deviations should be discussed with the Phycology 
Section Diatom Taxonomic Coordinator for inclusion in the project QA/QC notes. 

6.2. Typically, 10% - 15% of the samples collected as part of a study will be analyzed 
for quality control.  Two types of QA/QC analyses are commonly performed: a 
re-count of a diatom slide (taxa harmonization count or THC) and a complete re-
processing and re-count of the chosen QA/QC sample (replicate subsample count 
or RSC).  The THCs are performed on diatom samples only while the RSCs are 
performed on both diatom and non-diatom samples. Descriptions of specific 
procedures are in QA/QC protocol documents. 
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 Figure 1.  Diatom Slide Analysis form - NAWQA. 


